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Installation/Removal Instructions 

• Create a directory named ProUCL on the hard drive. 

• Caution: If you have previous versions of the program which 
were installed, you should remove or rename the directory that 
they are currently located in. 

• Download the two files proucl.EXE and OPNX32.DLL from 
the website and save them to the new ProUCL Directory. 

• You may also want to download the two folders USERS 
GUIDE (Users guide) and the DATA (sample data) 

• To run the program, use Windows Explorer to locate the file 
ProUCL application and double click on it or using the RUN 
command from the start menu, locate and run proucl.exe. 

• To uninstall the program, use Windows Explorer to locate and 
delete the ProUCL Folder. 

Minimum Hardware Requirements 

• Intel Pentium 200MHz 
• 10 MB of hard drive space 
• 48 MB of memory (RAM) 
• CD-ROM drive 
• Windows 98 

4 



Program ProUCL Menu Structure 

The menu structure of ProUCL is similar to a typical Widows 

program. The screen below appears when the program is executed. 

~-~ ProUCL Version 2 1 1!1!1~£1 

The following menu options appear on the screen 

1. File 

2. View 

3. Help 

The options available with these menu items are described next. 
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--~--------------... 
1. File 

Click on the File menu item to reveal these drop-down options. ,;: ... PmUCL VP-TSIIHI 2 1 

l!!lliJ E3 

The following File drop-down menu options are available: 
• New option: creates new spreadsheet. 

• Open option: browses the disk for a file. The browse program will start in the working directory if a directory has been set. 
• Working directory option: select and set a working directory. Note: A file within a directory must be selected before setting the directory. All subsequent files are read from and saved in the chosen working directory. 

• Print Setup option: sets printer options. 

• Click on a previously used file to re-open that file. • Exit option: exits ProUCL. 
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2. View 

Click on the View menu item to reveal these drop-down options. 

The following View drop-down menu options are available: 

• Toolbar: the Toolbar is that row of symbols immediately below 

the menu items. Clicking on this option toggles the display. 

This is useful if the user wants to view more data on the screen. 

• Status Bar: the Status Bar is the wide bar at the bottom of the 

screen which displays helpful information. Clicking on this 

option toggles the display. This is useful if the user wants to 

view more data on the screen. 
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3. Help 

Click on the Help menu item to reveal these drop-down options. 

The following Help drop-down menu options are available: 

• Help Topics option: at present no online help is available. This 
may be available in the next version of ProUCL. 

• About ProUCL: displays the program version number. 
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Main Menu Structure of ProUCL 

The following menu structure of ProUCL appears after opening or 

creating a data file. 

The following menu items are available. 

1. File 
2. Edit 
3. View 
4. Options 
5. Summary statistics 
6. Normality test 
7. UCL 
8. Window 
9. Help 

The options available with these menu items are described next. 
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1. File 

Click on the File menu item to reveal these drop-down options. 
The following File drop~down menu options are available: 

• New option: opens a blank spreadsheet screen. 

• Open option: browses the disk and selects a file which is then 
opened in spreadsheet format. The browse pro gram will start 
in the working directory if a working directory has been set. 

Recognized input format options: 
Text *.txt (tab delimited) 
Excel *.xis 
Lotus *.wk? 
Lotus *.123 
Default - *. * will be read in Excel format. 

• Close option: closes the active window. 
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• Save As option: allows the user to save the active window. 

Follows the Windows standard and writes to a file in Excel95 

format. All modified/edited data files, and output screens 

generated by the software, can be saved in Excel 95 format. 

• Working directory option: selects and sets a working directory 

for all I/0 actions. All subsequent files are read from and saved 

in the working directory. You must select a file before you set 

the working directory. 

• Print option: sends the active window to the printer. 

• Print Preview option: displays a preview of the output on the 

screen 

• Print Setup options: follow Windows standard. The user can 

chose the landscape format under this option. 
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Input File Format 

• The program can read Tab delimited Text (ASCII), Excel, and 
Lotus files. 

• Columns in a Text (ASCII) file should be separated by one tab. 
Spaces between columns are not allowed in this format. 

• The input data file should have column labels in the first row 
and data without text (e.g., non-numeric and blank values) for 
those variables in the remaining rows. 

• The data file can have multiple variables (columns) with 
unequal number of observations. 

• Non-numeric text may only appear in the header row (first row) 
of each column. All other non-numeric data (blank, other 
characters, and strings) appearing elsewhere in the data file are 
treated as zero entries. The user should make sure that his data 
set does not contain such non-numeric values. 

• Alternatively, a large value= 1E31 (=lxl031
) can be used for 

missing (blank, or non-numeric values) observations (just as in 
Scout (1999) software). All values with this large value are 
ignored from all of the computations. 

• Data in each column must end with a non-zero value. The last 
non-zero entry in each column is considered as the end of that 
column's data. If your data column ends with a zero value, that 
last zero value will be ignored. This may require you move 
observations around if your column data ends with zero values. 

• Note that all other zero data (in the beginning or middle of a 
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data column) are treated as valid zero values. 

At present, the program does not handle the left-censored data 

sets with non-detects. 

Result of Opening an Input Data File 

.:',... ProUCL Version 2.1 I!IJ;f£1 

• The data screen follows the standard Windows design. It can 

be resized, or portions of data can be viewed using scroll bars. 

• Note that scroll bars appear when the window is activated and 

the title bar is highlighted. 
2. Edit 
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Click on the Edit menu item to reveal drop-down options. 
The following Edit drop-down menu options are available: 

• Erase option: is used to remove the highlighted portion of the 
data. Note that the erased data is not written to any buffer and 
cannot be recovered. Therefore, when erased, it is gone. 

• Copy option: is similar to a standard Windows Edit option such 
as in Excel. It performs typical edit functions of copying 
highlighted data to a buffer. 

• Paste option: is similar to a standard Windows Edit option such 
as in Excel. It performs typical edit functions of pasting data 
from a buffer to the current spreadsheet cell. 

3.View 
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Click on the View menu item to reveal these drop-down options. 

The following View drop-down menu options are available: 

• Toolbar: the Toolbar is that row of symbols immediately below 

the menu items. Clicking on this option toggles the display. 

This is useful if the user wants to view more data on the screen. 

• Status Bar: the Status Bar is the wide bar at the bottom ofthe 

screen which displays helpful information. Clicking on this 

option toggles the display. This is useful if the user wants to 

view more data on the screen. 
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4. Options 

Click on the Options menu item to reveal these drop-down options. 

12600 
14ooo 
14900 -- -·· -- ~-..-- ·- _ ... - .. .,..... - ---- ~- ~ ··. ~- ·---·-~ ... ··--

Mn 
39800 
451oo 
37600 -- ...,_ ·- . .,.. -·-

Currently, Set Data is the only drop-down menu option available: 

• Set Data option: resets the active portion of the data window. 
The program examines the active spreadsheet and selects 
default values representing the first row of data (row 2), the last 
row which contains data (dependent on actual data), the 
leftmost column (typically column 1) where data and text occur, 
and the rightmost column (dependent on actual data) where data 
and text occur. Extreme caution should be taken when varying 
from the default values. 

• Note: This menu item is optional. The user can pre-process 
the data by using the Excel program. 
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The Data Location Screen 

The following Data location screen appears. 

• It is recommended to use the default settings for the data 

screen. This means that aU of the data will be processed. 

• The first row in the spreadsheet contains the alphanumeric text 

(column headings), not data. 

• The default top row of data is row 2. This value can be 

changed to process a subset of the data in the spreadsheet. 

• The default bottom row is the last row in the spreadsheet which 

contains nonzero data. This value can be changed to process a 

subset of the data in the spreadsheet. 

• The selected data must correspond to the same columns as the 

text in the first row. The Leftmost column value (column 

number) cannot be changed by the user. 
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• Caution: it is possible to confuse the program by highlighting 
a portion of the spreadsheet before invoking this option, 
unpredicted results will occur. 

• The Rightmost column number can be changed by the user. 
Note that you must have a column of data for any variable 
requested. 

• Caution: Blank cells in the top data row may confuse the 
automatic sizing algorithm. The user can manually override 
this confusion by re-setting the rightmost column value in this 
option. 

18 

----------~---~---~ 



5. Summary statistics 

• This option computes general summary statistics for all 

variables in the data file. 

• Two Choices are available: 

Raw data (the default option) 
Log-transformed data (Natural logarithm) 

• In ProUCL, Log-transform means natural logarithm (In). 

• When computing summary statistics for raw data) an 

informative message is displayed f£?r each variable which may 
contain non-numeric or non-positive values. 

• The Summary statistics option computes log-transformed data 

only if all of the data values for the selected variable are 
positive real numbers. A message will be displayed if non­
numeric characters, zero, or negative values are found in the 

column corresponding to the selected variable. 
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Summary Statistics 

Click on the Summary statistics menu item to reveal this drop-down 
option. 

When the user clicks on the Compute 
option button, the window given on 
the right appears. 

• Select your data choice, and click on the Compute button to 
continue or on the Cancel button to cancel the summary 
operations. 

• The results screen follows the standard Windows design. It can 
be edited, widened, printed, resized, or scrolled. 

• The resulting summary statistics screen can be saved as an 
Excel file. 
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Results Obtained Using the Summary Statistics Option 

,..~ ProUCL Yo~r,;oon 2 _1 J!!!IOO EJ 

·able nari-ie ___ · -- -- Numohs -Minimum--· MaXimum ·- Mean _ _,_ Median - · Stcr-
.. -- . ___ ... __ -----r----- - -··-------·.- ----. ~ ----~ ~ . ..----~ --- -------- .. -

i 

. -- ..... -------- .. . ·- - 1-- ........ - ,. -··j" - .... - ---- .. . . ----- . ·-·· ---- -···· . .... .. .. ;-j··· - ···-··--· ···--- ..... . 

~-==-~~-=-~=-±~-=--=~k--~:~l~=~~~~~1~5;;~~~---~2-~~] 8_:3:~ 
. 22 12.2 111,32.227273 24.675 24.0 

- ·-- --- ·-- ---- ·--:- -------22 ---- ·9:4-- ---6~n:rir9s2273'- 1'8275'14~67 

• ....,.,.?.:-=;J::.:---"--- -----------------22'-- -14oo ____ 653ooi34947.727:---3740614ooi 
.•.. -~~--·· - .. ··--··•.J .. -- . +····. .... " . * . . ••• -- - 'f'"' ·- •..•.. ·- .• 

.... ··-- ··-·- . 22 0.115 2400 8~_3.89159 699 508.5 

On the results screen, the following summary statistics are displayed 

for each variable in the data file. These are described in Appendix A. 

NumObs -Number of Observations. 

Minimum - Minimum value. 
Maximum- Maximum value. 
Mean- Average value. 
Median - Median value. 
Std. Dev.- Standard Deviation. 
CV - Coefficient of Variation. 

Skewness- Skewness statistic. 
Variance- Variance statistic. 

Printing Summary Statistics 

• The summary statistics results and all other results can be 

printed by clicking the Print option under the menu item File. 

It is recommended that these statistics be printed in landscape 

format which is available under the Print Setup option. 
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6. Histoeram 

• This option produces a histogram for a selected variable in the 
data file. 

• For data sets with more than one variable, the user should 
select a variable first. The histogram is computed and 
displayed for the selected variable, one variable at a time. 

~ By default, the program selects the first variable. 

• The user specifies if the data should be transformed. 

- The default choice is to display a raw data histogram. 

• Two Choices are available: 

Raw data (the default option) 
Log-transformed data (Natural logarithm) 

• In ProUCL, Log-transform means natural logarithm (In). 

• The user can select the number of bins for the histogram. 

The default is 15 bins. 

• Note that in order to display and capture the best histogram 
window, .the user may want to maximize the window before 
printing. 

22 



Histogram Screen 

• Click on the Histogram menu item and select the Draw 

histogram option. 

• Select Raw data or Log transformed data. 

• You can change the number of bins to display. 

• Select the variable you wish to view the histogram and then hit 

the display key to view the histogram. 

Histogram £1 

·,:, ,, ---
.. : ' NJmb~rat bin~: J15 

·,'·, :' 
~ . · ... 

Oisple.y 

:,';.:··:.· 

Ceincel 
f 
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________________ ........ 
Results of Histogram Option 

• The Histogram window shown above has been resized for display and reflects the default values shown on the previous page. 

• You may close the window using normal windows operations or click on the Close window button at the bottom left corner of the screen. 

• The histogram can be printed or copied by clicking on the right button on mouse. 
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7. Normality test 

• This option tests the normality or lognormality of the variable 
selected by the user. 

• For data sets with more than one variable, the user should 
select a variable first. The normality is tested and displayed 
for the selected variable, one variable at a time. 

- By default, the program selects the first variable. 

• The user specifies the transformation (normal or lognormal). 

- The default choice is to test for normality. 

• The user specifies level of significance. Three choices are 
available for the level of significance: 0.01, 0.05, or 0.1 

- The default choice for level of significance is 0.05 

• . The program ProUCL plots a normal quantile-quantile (Q-Q) 

plot for the selected variable (or the log-transformed variable). 

• · The linear pattern of the Q-Q plot suggests approximate 
normality (or lognormality). 

• The Program computes the intercept, slope, and correlation 

coefficient for the linear pattern displayed by the Q-Q plot. A 
high value (e.g., >0.95) of the correlation coefficient is an 
indication of approximate normality. Note that these statistics 

are among those displayed on the Q-Q plot. 
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• Typically, on this graph, observations well separated from the 
bulk (central part) of data are potential outliers needing further 
investigation. 

• In addition to the graphical Q-Q plot, two more powerful 
procedures are also available to test the normality or 
lognormality of the data. These are: 

Lilliefors Test: a test typically used for samples of larger 
size(> 50). When the sample size is greater than 50, the 
program defaults to the Lilliefors test. However, note 
that the Lilliefors test is available for samples of all sizes. 

Shapiro and Wilk W-Test: a test used for samples of 
smaller size (<=50). At present, W-Test is available only 
for samples of size 50 or less. 

• ProUCL computes the relevant test statistic and the associated 
critical value, and prints them on the associated Q-Q plot. 

• On this Q-Q plot, the program informs the user if the data are 
normal (or lognormal). 

• The Q-Q plot can be printed or copied by clicking the right 
button on the mouse. 

• Note that in order to capture the entire g~aph window, the user 
may want to maximize the window before printing. 
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Normality test Screen 

• Click on the Normality test menu item and select the Perform 

normality test option. 

,;~ ProUCL YPrsron 2 1 l!!lef £J 

• Select either the Normal option or the Lognormal option. 

• Select the variable, select a Level of Significance, and then 

click on the test (Lilliefors or Shapiro-Wilk) you wish to 

pe rf 
Normality Test EJ or· m . 
'. .. . / 

_____ u_·m_aro_~ __ T_es~t-·~~~ She.pirl:l-Wilk Test j _______ ee.n_ce_l __ __, 
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Results of Normality test Option 

• The Q-Q plot window shown above has been resized for display. 

• Two different Q-Q plot windows are produced for each Normality test request: using the original data (shown above) and the standardized data. 
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8. UCL 

• This option computes the UCLs for the selected variable. 

• This option allows the user to choose one or more methods 

from the several (10) available methods to compute a UCL of 

the population mean. 

• By default, the program computes UCLs using all available 

methods. 

• The user specifies the confidence level: a number in the interval 

(0.5, 1 ). The default choice is 0.95. 

• The program computes several non-parametric UCLs using the 

Central Limit Theorem, Chebyshev inequality, Jackknife, and 

Bootstrap procedures. 

• For the bootstrap method, the user can specify the number of 

bootstrap runs. The default choice for the bootstrap runs is 

2000. 

• The user is responsible for making an appropriate choice about 

data distributions- normal or lognormal. The user determines 

the data distribution using the normality test option. The 

program informs the user if the data are normal or lognormal. 

The program computes the relevant statistics using this choice. 

• For data sets which are neither normal nor lognormal, ProUCL 

computes UCLs using non-parametric procedures. 

• For lognormal data sets, ProUCL can compute only a 90% or a 
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95% H-statistic based H-UCL of the mean. For all other 
methods, it can compute a UCL for any confidence coefficient 
in the interval (0.5, 1.0). 

• For lognormal distributions, when the user wants to compute a 
95% UCL, ProUCL also provides a recommended UCL . 
computation procedure. This is particularly helpful when the 
skewness is high, that is, the standard deviation of the log­
transformed data starts exceeding 1. 

• For lognormal data sets, the program also computes the 
Maximum Likelihood Estimates (MLEs) of the population 
percentiles, and the minimum variance unbiased estimates 
(MVUEs) of population mean, median, standard deviation, and 
the standard error (SE) of the mean. 

• ProUCL can compute the H-UCL for samples of size up to 
1000 using the critical values as given by Land ( 197 5). 

• The detailed theory and formulae to compute these statistics 
are given by Land (1971, 1975), Gilbert (1987), Singh, Singh, 
and Engelhardt (1997, 1999), and Singh et al. ( 2000). 

• For the sake of completeness ofthis User's Guide, all formulae 
and methods used in the development of the program Pro UCL 
are summarized in Appendix A. 
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UCL Computation Screen 

Click on the UCL menu item and then click on the All-UCL option. 

~~ PwUCL Versmn? J !IJiiEJ 

• Note that the UCLs are computed for one variable at a time. 

The user selects a variable from the variable list. 

select ve.r!able s ----(!]·:.:..:.:· As 
Cr 

·eo 
Fe 

· Mn 
Se 
Sl 

.. 
. ' 

·' 

• The user may change the Confidence Coefficient (Default is 

0.95). The range allowed is between 0.5 and 1.0. 

Confidence Coefficent (0.5, 1.0) 

,0.95 
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• The user may adjust the number of bootstrap runs (Default is 
2,000) 

• The user selects the Normal or Lognormal 
Data option 

• The user may de-select any unwanted UCL computations 
procedures. 

• Finally, the user clicks on the Compute UCL button. 
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Results Screen of UCL Computations 
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~ -0.209682 • . Data.not"Lognormal at 5% Significance Level 
·Data are_ f>Jorm~l:_·use st\Jdenrs~.t.iJC_L~·- · ··· · 

95 <!.II uci.. (Assuming-Normal baiei). --
1U~d~~~·9.~"''s-r --- - .. · - .13208.024 - Estimates A55urriingLognormat DistribUtion 

· MLE Mean- - · · · .. ·· -12038.177 
-- --ss% UcC (Adiusted for sl<eWr1ess) -- MLE standard Deiilation · - '5533 4601 

tl"\atusltlo-\..L.T ·13103.639 MLE Coefficient of variation 0.4679612 
.. _______ -~ :~~- ·---~~-!:gQ1.J_~_:_- MLESk9vffiess ·- ... · - ·· T5bs3S15---

· · · MLEMedta-n ------ .... ------·10903.3ie·· ---

--95·%-Nori-parametri'cUcC·- ·----- ---- MLE-86% 6uanti\e-- ·--- --1saso.52r---
_13143.962 MLE90%Quantile -19315.184 

13208.024 · MLE 95% Quantile 22671.073 
13088.658 ~-~~~-~-~ ·.tvl~~-9~~ a~an~_lll. __ ~---- --·- ~OS9?)l76 

: 13109.41 
· (Me~n.·::·std)_.: :~:~~~ . 1?i3? o~ ~: --- ···· ··· 

• On the output ofProUCL, Chebyshev (Mean, Std) stands for 

a Chebychev UCL of the mean computed using the sample 

arithmetic mean and standard deviation. 

• 95% Chebyshev (MVUE) UCL stands for a 95% UCL of the 

mean obtained using the MVUEs of the mean and standard 

error, of the mean assuming a lognormal distribution. 

• 99% Chebyshev (MVUE) UCL stands for a 99% UCL of the 

mean obtained using the MVUEs of the mean and standard 

error of the mean assuming a lognormal distribution. 
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9. Window 

Click on the Window menu to reveal these drop-down options, 

12600 6.8 - -1s~T --3s8ob ---
14000 - -- -- r -- 19~5 --- 451(m ----
14soo 5.1 17.6 376oo 
14100 6.15 24.55 2o:6 40450 ·9s'fif-- - s.3- -- ·-- __ 17 ____ -- 1n · · 26sao --
s11o 4.2 .. 24.8 · 14.7 386oo· 

13soo· 69 17.4 · 21.2 4270o 121 o 34 -iisoo _____ f ___ 2in·- -- 14- -4iaoo - ·4a9 --- - -
-- 9110' -- 4.4, 2f - . 10.7. :-26700-.- 434' -- -

14600 5.2 13.1 10.4 31300. 586 

The following Window drop-down menu options are available: 

• New Window option: opens a blank spreadsheet window 

• Cascade option: arranges windows in a cascade format. This 
is a typical Windows program option. 

• Tile option: resizes each window and then displays all open 
windows. This is a typical Windows program option. 

• Arrange Icons is a typical Windows program option. 

• The drop-down options include a list of all open windows 
with a check mark in front of the active window. Click on 
any window listed to make that window active. 
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to. Rein 

Click on the Help menu item to reveal these drop-down options. 

The following Help drop-down menu options are available: 

• Help Topics option: at present no online help is available. 

This may be available in the next version ofProUCL 

• About ProUCL: displays the program version number. 
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Run Time Notes 

• If you have multiple windows open as shown below, you no 
longer need to make sure to highlight the data window before 
performing any computations. 

=~~~L- q.3_~~ 
1 

0.17 
0.488 

0.4 
0.5 

0.34 
1.1 

• You can now do Summary Statistics, Normality Test or UCL 
with the screen like the above. 
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• Cell size can be changed. The user can change the size of a 

cell by moving the mouse to the top column (the grey shaded 

column with a letter), then moving the mouse to the right side 

until the cursors changes to an arrow symbol ( ++ ), depress 

the left mouse button. 

• 

,.;~- ProUCL Vers10n 2 1 J!!ll~£1 

For Help. press Fl ···- -·- -·· -----~~ -~- ·- -·-· ----- _..,:_ ____ : ____ ..:...,._.:_ .. __:_ --~-

can be used to reveal additional precision or hidden text. 
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Rules to remember when editing or creating a new data file. 

• Text may appear in the first row only. This row has column 
headers (variable names) for your data. 

• AH alphanumeric text (including blanks, strings) appearing 
elsewhere (other than first row) will be treated as zero data. 

• Missing data (alphanumeric text, blanks) can be set to a large 
value= 1E31. All entries with this value will be ignored from 
the analysis. 

• The last data entry for each column must be non-zero. The 
program determines the number of observations by working 
backwards up the data until a non-zero value is encountered. 
Data in each column must end with a non-zero entry as 
shown above otherwise that zero value will be ignored. Note 
that, all intermediate zero entries are treated as valid data. 

• It is recommended to use the default settings of the Data 
location screen when working with your data. 

Recommendations to Compute a 95°/o UCL of the Population 
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Mean (The Exposure Point Concentration (EPC) Term) 

This section describes the recommendations on the computation 

of a 95% UCL of the unknown population arithmetic mean, ll1 of 
a contaminant data distribution. These recommendations are based 

upon the findings of Singh, Singh, and Engelhardt (1997" 1999) and 

Singh et al. (2000). Recommendations have been summarized for: 

1) normally distributed data sets, 2) lognormally distributed data sets, 

and 3) data sets which are neither nonnal nor lognormal (non­

parametric data). 

Normally Distributed Data sets 

• For normally distributed data sets, a UCL based upon the 

Student's t-statistic provides the optimal UCL of the 

population mean. Therefore, for normal data sets, one should 

use a 95o/o UCL based upon Student's t-statistic. 

• The 95% UCL of the mean based upon Student's t can also be 
used when the sd, {} (an estimate of a) of the log-transformed 
data is less than 0.5, or when the data set approximately follows 
a normal distribution. 

Lognormally Distributed Data sets 

For lognormal distributions, since skewness is a function of{}, 

recommendations for the UCL computation methods (Table 1) are 

summarized for various values of{} and the sample size, n. Note that 

the following table is applicable to the computation of a 95% UCL 

of the population arithmetic mean (AM) based upon lognormally 

distributed data sets. 

Note: c; represents the sd of log-transformed data. 
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Table 1. Summary Table for the Computation of a 
95% UCL of the Unknown Mean, 1-Ln of a Lognormal 

p ) ti opu a on 

0 Sample Size, Recommendation 
n 

6 < 0.5 For all n (~5) Student's tor H-UCL 

o.s ~ a < For all n H-UCL 
1.0 

1.0 :s; 0 < 1.5 n < 25 95% Chebyshev (MVUE) UCL 

n ~ 25 H-UCL 

n<20 99% Chebyshev (MVUE) UCL 
1.5 :s: a <2.0 

20:s; n<50 95% Chebyshev (MVUE) UCL 

n~50 H-UCL 

n<25 99% Chebyshev (MVUE) UCL 
2.0 :s; a <2.5 

25 :s; n < 70 95% Chebyshev (MVUE) UCL 

n ~ 70 H~UCL 

n < 30 Larger of (99% Chebyshev (MVUE) UCL, 
99% Chebyshev(Mean, Std)) 

2.5 s 0 <3.0 
30 s. n <70 Larger of (95% Chebyshev (MVUE) UCL, 

95% Chebyshev(Mean, Std)) 

n ~70 H-UCL 

n small Needs further investigation 
3.0 s. 0 

n>lOO H-UCL 
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Data Sets Without a Discernable Distribution (Non-parametric) 

• For mild to moderately skewed data sets (e.g., o in the interval 

(0.5, 1)), one may use a 95% Chebyshev (Mean, Std) UCL for 

the population mean, Jl1• Note o is sd of log-transformed data. 

• For moderate to highly skewed data sets (e.g., in 6 the 

interval (1.0, 2.0)), one may use a 97.5% Chebyshev (Mean, 

Std) UCL for the population mean, jl1• 

• For highly skewed to extremely highly skewed data sets with 

6 in the interval (2.0, 3 .0), one may use a 99%) Chebyshev 

(Mean, Std) to compute a UCL of the population mean, jl 1• 

• Extremely skewed data sets with 6 exceeding 3.0 are not well­

behaved and need further investigation. For such data sets, 

even a 99% Chebyshev (Mean, Std) UCL may fail to provide 

the specified coverage to the population mean. This is 

especially true when the sample size is small. 

• It is observed that the UCL based upon the bootstrap-t 

procedure is more conservative than the UCLs obtained using 

the Student's-t modified-t, adjusted-CLT, and standard 

bootstrap methods. This procedure was not included in the 

Monte Carlo simulation study conducted by Singh et aL 

(2000). It is likely that the UCL based upon the bootstrap t~ 

procedure may provide better coverage of the population mean. 

This procedure needs further investigation. 

• It is also desirable to use other distributions, such as the Gamma 

and W eibull distributions, to model highly skewed data sets. 

It should be pointed out that, depending upon his or her application, 
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the user may decide to use (or not use) any of the 10 available 
procedures incorporated in the program, ProUCL. 

42 



APPENDIX A 

TECHNICAL BACKGROUND 

METHODS FOR COMPUTING THE EPC TERM ((l-ex) 100°/o UCL) 
AS INCORPORATED IN THE PROGRAM ProUCL 



METHODS FOR COMPUTING THE EPC TERM ((1-o:) 100%UCL) 

AS INCORPORATED IN THE PROGRAM ProUCL 

1.0 Introduction 

In environmental applications of the U.S. EPA, exposure assessment and 

cleanup decisions are often made based upon the mean concentrations of the 

contaminants of potential concern. A 95% upper confidence limit ( UCL) of the 

unknown population arithmetic mean (AM), 1J.1 , is often used to: estimate the 

exposure point concentration (EPC) term (EPA, 1992), determine the 

attainment of cleanup standards (EPA, 1989 and 1991 ), estimate background . 
level contaminant concentrations, or compare the soil concentrations with site 

specific soil screening levels (EPA, 1996). It is, therefore, important to 

compute a reliable, conservative, and stable 95% UCL of the population mean 

using the available data. 

Computation of a (1-o:) 100% UCL of the population mean depends 

upon the data distribution. Typically, environmental data are positively 

skewed, and a default lognormal distribution (EPA, 1992) is often used to 

model such distributions. The H-statistic based Land's (Land 1971, 1975) H­

UCL ofthe mean is used in these applications. Hardin and Gilbert ( 1993), and 

Singh, Singh, and Engelhardt (1997,1999), Singh et al. (2000), pointed out 

some problems associated with the use of the lognormal distribution and the 

H-UCL of the population AM. In practice, for skewed lognonnal data sets 

with high standard deviation (sd), a of the natural log-transformed data (e.g., 

a exceeding 1.5), the H- UCL can become unacceptably large, exceeding the 

95% and 99% data quantiles, and even the maximum observed concentration, 
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by orders of magnitude (Singh, Singh, anc;l Engelhardt, 1997). This is 

especially true for samples of small sizes with high values of o (or its estimate, 

sy). In those cases, the maximum observed concentration is used as an estimate 

of the EPC term (EPA, 1992) in exposure assessment applications. 

The program, ProUCL, has been developed to test normality or 

lognormality ofthe data distribution, and to compute a conservative and stable 

UCL of the population mean. Singh, Singh, and Engelhardt (1997, 1999, 2000) 

studied several parametric and non-parametric UCL computation procedures 

which have been included in the program, ProUCL. All mathemat~cal 

algorithms and formulae used by ProUCL to compute the various statistics are 

summarized in this Technical Background Appendix, A. ProUCL computes 

the various summary statistics for raw, as well as log-transformed data. In this 

User's Guide and in ProUCL, log-transform (log) stands for the natural 

logarithm (In) to the base e. ProUCL also computes the maximum likelihood 

estimates (MLEs) and the minimum variance unbiased estimates (MVUEs) of 

various unknown population parameters. This, of course, depends upon the 

underlying data distribution. Based upon the data distribution, ProUCL 

computes the (1 -a) 100% UCLs of the population mean using parametric and 

non-parametric procedures. It is observed that the Chebyshev inequality based 

UCLs provide conservative alternatives to compute a 95% UCL of the mean 

from moderately to highly skewed lognormal data sets, and other skewed non­

lognormal data sets. 

At present, Pro UCL does not handle non-detects and missing data. The 

program can be modified (e.g., in the next version ofProUCL) to incorporate 

procedures which can be used to compute estimates of the population mean 



and standard deviation, and a UCL ofthe mean for left-censored data sets with 

non-detects. 

2.0 Procedures to Test Normality and Lognormality of a Data set 

ProUCL tests the normality or lognonnality of the data set using the 

three different procedures described below. The program tests normality or 

lognormality at three different levels of significance, namely, 0.01, 0.05, and 

0.1. The details of these procedures can be found in the references cited. 

2.1 Quantile-Quantile (Q-Q) Plot 

This is a simple graphical procedure to test for approximate normality 

or lognormality of a data distribution (Hoaglin, Mosteller, and Tukey (1983), 

Singh (1993)). A linear pattern displayed by the bulk of the data suggests 

approximate normality or lognonnality of the data distribution. For example, 

a high value (e.g., 0.95 or greater) of the correlation coefficient of the linear 

pattern suggests approximate normality (or lognormality) of the data set under 

study. On this graphical display, observations well separated from the linear 

pattern displayed by the bulk data represent the outlying observations. The 

graphical Q-Q plot test should always be accompanied by other more powerful 

tests, such as the Shapiro-Wilk test or the Lilliefors test. The program ProUCL 

always performs the graphical Q-Q plot test on raw data as well as on 

standardized data. 
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2.2 Shapiro-Wilk W Test 

This is a powerful test and is often used to test the normality or 

lognormality of the data distribution under study (Gilbert, 1987). The program 

ProUCL, performs this test for samples of size 50 or smaller. Based upon the 

selected level of significance and the ~omputed test statistic, ProUCL also 

informs the user if the data are normally (or lognormally) distributed. The user 

should use this information to obtain an appropriate UCL of the mean. The 

program prints the relevant statistics on the Q-Q plot of the data (or the 

standardized data). For convenience, the normality (or lognormality) test 

results at 0.05 level of significance are also displayed on the UCL output 

Excel summary sheet. 

2.3 Lilliefors Test 

This test is particularly useful for data sets of larger size (Dudewicz and 

Misra, 1988). ProUCL performs this test for samples of sizes up to 1000. 

Based upon the selected level of significance and the computed test statistic, 

· ProUCL also informs the user if the data are normally (or lognonnally) 

distributed The user should use this information to obtain an appropriate 

UCL of the mean. The program prints the relevant statistics on the Q-Q plot of 

data (or standardized data). For convenience, the normality (or lognormality) 

test results are also displayed on the UCL output Excel summary sheet 
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3.0 Data 

Letx1,x2, ... ,x
11 

be a random sample from the underlying population (e.g, 

remediated part of a site) with unknown mean, ll n and variance, a 1
2

• Let ll 

and a represent the population mean and the population standard deviation (sd) 

of the log-transformed (natural log to the base e) data. Let y and sY ( = a) be 

the sample mean and samplesd, respectively, of the log-transformed data,y; = 

ln(x;); i = 1, 2, ... , n. Specifically, let 

(1) 

(2) 

Similarly let x- and sx be the sample mean and sd of the raw data, x1 , x2 , •• 

, X11, obtained by replacingy by x in equations ( 1) and (2), respectively. In this 

User's Guide, irrespective ofthe underlying distribution, J.L 1, and o /represent 

the mean and variance of the random variable X (in original units), whereas 

J.L and cr2 are the mean and variance of its logarithm, given by Y =ln(X). 

4.0 Lognormal Distribution and Parameters of Interest 

If Y = ln(X) is normally distributed with mean IJ. and variance a 2
, X is 

said to be lognonnally distributed with parameters ll and o2 and is denoted by 

LN(J.L, o2
) • ft should be noted that lJ and o2 are not the mean and variance of 

the lognormal random variable, X, but they are the mean and variance of the 

log-transformed random variable Y, whereas IJ. 1, and a 1
2 represent the mean 
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and variance of X. The parameters of interest of a two-parameter lognormal 

distribution, LN(!J., o 2
), are given as follows: 

Mean (3) 

Median = M = exp(p) (4) 

Variance (5) 

Coefficient ofVariation "'cv = o111-L1 = V(exp(o- 1 )-1) (6) 

Skewness "' (CV)3 + 3(CV) (7) 

4.1 MLEs of the Parameters of Lognormal Distribution 

For lognormal distributions, note that y and sY (=o) are the maximum 

likelihood estimators (MLEs) of~ and o, respectively. The MLE of any 

function of the parameters 1..1. and o2 is obtained by simply substituting these 

MLEs in place of the parameters (Hogg and Craig, 197 8, Bain and Engelhardt, 

1992). Therefore, replacing ~and a by their MLEs in equations (3) through 

(7) will result in the MLEs (but biased) of the respective parameters of the 

lognormal distribution. The program ProUCL computes all of these MLEs for 

lognormally distributed data sets. 

4.2 Relationship Between Skewness and Standard.Deviation, a 

Note that for a lognonnal distribution, the CV (given by equation (6) 

above) and the skewness (given by equation (7)) depend only on o. Therefore, 
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in this User's Guide and also in the program ProUCL, the standard deviation, 

a (sd of log-transformed variable), or its MLE, sY (=o) has been used as a 

measure of skewness of lognormal and of other positively skewed data sets. 

The larger is the sd, the larger are the CV and the skewness. 

For example, for a lognormal distribution: with a = 0.5, the skewness 

= 1.75; with a =1.0, the skewness= 6.185; with a =1.5, the skewness= 

33.468; and with a= 2.0, the skewness= 414.36. Thus, the skewness of a 

lognormal distribution becomes very large as a starts approaching and 

exceeding 2.0. 

It is observed (Singh, Singh, Engelhardt (1997), and Singh et al. (2000)) 

that for smaller sample sizes (such as smaller than 30), and for values of a 

approaching 2.0 (and skewness approaching 414) , the use of the H-statistic 

based UCL results in impractical and unacceptably large values. The various 

degrees of skewness of a data set as used in ProUCL and in this User's Guide 

are summarized as follows. 

Skewness as a Function of a (or its MLE, sy =o) 

Standard Deviation 

a< 0.5 

0.5 s; 0 < 1.0 

1.0 ~ 0 < 1.5 

1.5 ~ 0 < 2.0 

2.0 sa< 3.0 

0 ~ 3.0 

Skewness 

Symmetric to mild skewness 

Mild Skewness to Moderate Skewness 

Moderate Skewness to High Skewness 

High skewness 

Extremely high skewness 

Not well-behaved data sets - require further 

investigation 
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4.3 MLEs of the Quantiles of a Lognormal Distribution 

For highly skewed (e.g., a exceeding 1.5), lognormally distributed 

populations, the population mean, IJ. 1,can exceed the higher quantiles (e.g., 

80%, 90%, 95%) of the distribution. Therefore, the computation of these 

quantiles is also of interest. This is especially true when one wants to use the 

MLEs of the higher order quantiles (e.g., 95%, 97.5% etc.) as an estimate ofthe 

EPC term. The formulae to compute these quantiles are briefly described 

here. 

The pth quantile (or lOOpth percentile), xP. of the distribution of a 

random variable, X, is defmed by the probability statement, P(X ~ xP) = p. If 

zP is the pth quantile of the standard normal random variable, Z, with P(Z ~ 

zp) = p, then the pth quantile of a lognormal distribution is given by xP = exp(J.l 

+ zPo ). The MLE of the pth quantile is given by 

(8) 

For example, on the average, 95% of the observations from a lognormal LN(J.l, 

a 2
) distribution would lie below exp(IJ. + 1.65a). The 0.5th quantile of the 

standard normal distribution is z0.5 = 0, and the O.Sth quantile (or median) of 

a lognormal distribution is M = exp(IJ ), which is obviously smaller than the 

mean, J.L 1, as given by equation (3). Also note that the mean, 1J 1• is greater 

than xP if and only if a> 2zP. For example, when p = 0.80, zP = 0.845, J..L 1 

exceeds 

x 0 .80 , the 80th percentile if and only ifo > 1.69, and, similarly, the mean, J.L 1• 



will exceed the 95th percentile if and only if a> 3.29. 

The program ProUCL computes the MLEs of the 50% (median), 90%,95%, 

and 99% quantiles of a lognonnally distributed data set. 

4.4 MVUEs of Parameters of a Lognormal Distribution 

Even though the sample AM, x , is an unbiased estimator of the 

population AM, ~,. it does not have the minimum variance (MV). The MV 

unbiased estimates (MVUEs) of ~1 and oi of a lognormal distribution are 

given as follows, 

(9) 

(10) 

where the series expansion of the function gn( u) is given in Bradu and Mundlak 

(1970), and Aitchison and Brown (1976). Tabulations of this function are also 

provided by Gilbert (1987). Bradu and Mundlak (1970) give the MVUE of the 

variance of the estimate j.L'1, 

(11) 

f The square root of the variance given by equation (11) is called the standard 

error (SE) of the estimate, j.L'" given by equation (9). Similarly, a MVUE of 

the median of a lognomial distribution is given by 
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~ ;";\ 2 
M = exp(y ,gn( -sy /(2(n-l))). (12) 

For lognormal data, ProUCL computes these MVUEs given by equations (9) 

through (12). 

5.0 Methods for Computing a UCL of the Unknown Population Mean 

The program, ProUCL, computes a (1-a) 100% UCL ofthe population 

mean using the following ten procedures. 

1. Student's t-statistic - assumes normality or approximate normality. 

2. Modified t-statistic- for skewed distributions. 

3. Central Limit Theorem (CL1)- a non-parametric procedure. 

4. Adjusted Central Limit Theorem (Adjusted-CL1) - for skewed 

distributions. 

5. Land's H-Statistic - assumes lognormality. 

6. Chebyshev Theorem using the sample arithmetic mean and sd (denoted 

by Chebyshev (Mean, Std)) -a non-parametric procedure. 

7. Chebyshev Theorem using the MVUE of the parameters of a lognormal 

distribution (denoted by Chebyshev (MVUE))- assumes lognormality. 
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8. Jackknife procedure -a non-parametric procedure. 

9. Standard Bootstrap procedure -a non-parametric procedure. 

10. Bootstrap t procedure- a non-parametric procedure. 

The program computes a (l-ex) 1 00 % UCL (except for the H-UCL) of 

the mean for any confidence coefficient (1-rx.) value lying in the interval (0.5, 

l.O). For the computation oftheH-UCL, only two confidence levels, namely, 

0.90 and 0.95, are supported by ProUCL. Based upon the sample size, n, 

skewness, and the data distribution, the program also makes 

recommendations on how to obtain an appropriate 95% UCL of the unknown 

population mean. These recommendations are summarized in the 

Recommendations and Summary Section 6.0 of this appendix. The various 

algorithms and procedures used to compute a (1-a) 100% UCL of the 

population mean as incorporated in ProUCL are described as follows. 

5.1 (1-rx.) 100% UCL of the Mean Based Upon Student's t-Statistic 

The widely used well-known Student's t- statistic is given by, 

(13) 

where x and sx are, respectively, the sample mean and sample standard 

deviation obtained using raw data. If the data are a random sample from a 

normal population with mean, tJ- 1, and standard deviation, o 1, then the 

distribution of this statistic is the familiar Student's t distribution with n- 1 
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degrees of freedom. Let ta., n-l be the upper <X quantile of the Student's t 

distribution with n-1 degrees of freedom. 

A (1-o:)JOO% UCL of the population mean, }l1, is given by, 

(14) 

For a normally (when the skewness is about 0) distributed population,_ equation 

(14) provides the best way of computing a UCL of the mean. It should be 

pointed out that even for mildly to moderately skewed data sets (e.g., when a 

starts approaching and exceeding 0 .5), the UCL given by ( 14) may not provide 

the desired coverage to the population mean. This is especially true when the 

sample size is smaller than 20-25 (Singh et al. 2000). The situation gets worse 

for higher values of the sd, a, or its estimate, sY. 

5.2 (l-ex) 100% UCL of the Mean Based Upon Modified-t Statistic for 

Asymmetrical Populations 

Chen (1995); Johnson (1978); Kleijnen, Kloppenburg, and Meeuwsen 

(1986); and Sutton (1993) suggested the use of a modified t-statistic for 

testing the mean of a positively skewed distribution (including the lognormal 

distribution). The (1 -a.)JOO% UCL of the mean thus obtained is given by 

(15) 

where Jl3 , an· unbiased moment estimate (Kleijnen, Kloppenburg, and 

Meeuwsen, 1986) of the third central moment, is given as follows, 
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n 

jl3 == n L (xi -X)3 /[(n-l)(n-2)]. (16) 
j :1 

It should be pointed out that this modification for a skewed qistribution 

4oes not....Qerform well e,yen for mildly to moderately skewed data sets (e.g., 

'Yhen o starts approaching and exceeding 0.75} Specifically, it is observed 

that the UCL given by equation (15) may not provide the desired coverage 

of the population mean, j.L1, when a starts approaching and exceeding 0.75 

(Singh, et al., 2000). This is especially true when the sample size is smaller 

than 20-25. This small sample size requirement increases as a increases. For 

example, when a starts approaching and exceeding 1.5, ~the UCL given by 

equation (15) does not provide the. specified coverage (e.g., 95%) even for 

samples as large as 1 Oj). -
5.3 (1-a) 100% VCL ofthe Mean Based Upon The Central Limit Theorem 

The Central Limit Theorem (CLT) states that the asymptotic distribution, 

as n approaches infinity, of the sample mean, _x:, is normally distributed with 

mean, J.L1, and variance, a/ln. More precisely, the sequence of random 

variables given by 

(17) 

has a standard normal limiting distribution. In practice, this means that for 
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large sample sizes, n, the sample mean, x, has an approximate nonnal 

distribution irrespective of the underlying distribution function. Since the 

CLT method requires no distributional assumptions, this is a non-parametric 

method. 

As noted by Hogg and Craig (1978), if a 1 is replaced by the sample 

standard deviation, sx, the normal approximation for large n is still valid. This 

leads to the following approximate large sample non;parametric (1-a) 1 00% 

UCL of the mean, 

(18) 

An often cited rule of thumb for a sample size with the CLTmethod is 

n ~ 30.J:Iowever, this may not be adequate if the population is skewed, 
.... .... ...... ,. 
specifically when, g. starts exceeding 0. 5 (Singh, Singh, Enget?ardt, Nocerino 

(2000)). A refinement of the CLTapproach, which ~akes an adjustment for 

skewness as discussed by Chen (1995), is given as follows. 

5.4 (1-rx) 100% UCL of the Mean Based Upon The Adjusted Central Limit 

Theorem (Adjusted -CL1) 

The "adjusted-CLT" UCL is obtained if the standard normal quantile, 

za in the upper limit of equation ( 18) is replaced by (Chen, 1995) 

(19) 

Thus, the adjusted (1 - rx)IOO % UCL for the mean, p1 , of skewed 
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distributions is given by 

(20) 

k~ , the coefficient of skewness (raw data) is given by 

Skewness (raw data) k~ = P./ s;, (21) 

where Jl3, an unbiased estimate of the third moment, is given by equation . 

(16). 

As with the modified-t UCL, it is observed that this adjusted-CLT UCL 

may !!ot J!Ovide adequate coverage .to the population mean when the 

population is skewed, specifically 'Y,hen a starts approaching and exceedi~ 

2,:lli8ingh, Singh, Engelhardt, Nocerino (2000)). This is es_gecially true wh:_n 

the sample size' is smaller than 20-25. This small sample size requirement -increases as o increases. For example, when o starts approaching and 

exceeding 1.5),the UCL given by equation (20) does not provide the specified 

coverage (e.g., 95%), even for samples as large as 100 .• --
Thus, the UCLs based upon these skewness adjusted methods, such as 

the Johnson's modified t and Chen's adjusted CLT, do not provide the 

specified coverage to the population mean for mildly to moderately skewed 

(e.g., a in (0.5, 1.0)) data sets, even for samples as large as 100. The coverage 

of the population mean by these UCLs gets worse for highly skewed data 

sets. 
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5. 5 (1-a) 100% UCL of the Mean Based Upon the H-Statistic (H-UCL) 

The one-sided (1-cx)JOO% UCL for the mean, ~h of a lognormal 

distribution as derived by Land ( 1971, 197 5) is given as follows: 

(22) 

Tables of H -statistic values can be found in Land ( 197 5) and also in Gilbert 

( 1987). Theoretically, when the population is lognormal, Land (1971) showed 

that the UCL given by equation (22) possesses optimal properties and is the 

uniformly most accurate unbiased confidence limit. However, it is noticed that 

in practice, the H-statistic based results can be quite disappointing and . ~ 

misleading especially when the data set consists of outliers, or is a mixture 

from two or more distributions (Singh, Singh, and Engelhardt, 1997, 1999). 

Even a minor increase in the sd, sY, dras~ically inflates theMVUE ofJ.L 1 and the 

associated H-UCL. The presence of low as well as high data values increases 

the sd, sY, which in turn inflates the H-UCL. Furthermore, it is observed 
• 

(Singh, Singh, Engel?ardt, and Nocerino, 2000) that for smaller sample sizes 

(smaller than 15-25), and for values of a approaching 1.0 and higher (for 

moderately skewed to highly skewed data sets), the use of H-statistic based 

UCL results in impractical and unacceptably large UCL values. 

5.6 (l-ex) 100% UCL of the Mean Based Upon The Chebyshev Theorem 

(Using the Sample Mean and Sample Sd) 

The two-sided Chebyshev theorem (Hogg and Craig, 1978) states that 
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given a random variable, X, with finite mean and standard deviation,~~ and 

a1, we have 

(23) 

This result can be applied on the sample mean, x, to obtain a conservative 

UCL for the population mean, J-1 1. For example, if the right side of equation 

(23) is equated to 0.95, then k= 4.47, and UCL ='i +4.47o/..;n is a conservative 

95% upper confidence limit for the population mean. Of course, this would 

require the user to know the value of a 1• The obvious modification would be 

to replace cr 1 with the sample standard deviation, sx, but since this is estimated 

from data, the result is no longer guaranteed to be conservative. In general the 

following equation can be used to obtain a (1-a) 100% UCL of the population 

mean, 

UCL ::: ~ + -J(l/ a)s I ...,fn 
X • (24} 

A slight refinement of equation (24) is given (suggested by S. Ferson) as 

follows, 

UCL =X+ .j((ll a)-l)s 1.../n 
X . (25) 

The program, ProUCL, computes the Chebyshev (1-a) 100% UCL of the 

population mean using equation (25). This UCL is denoted by Chebyshev 

(Mean, Std) on the output of the program, ProUCL. Since this Chebyshev 

method requires no distributional assumptions about the data set under study, 

this is a non-parametric procedure. This UCL may be used as an estimate of the 
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upper confidence limit of the population mean when data are neither normal 

nor lognormal, especially when sd, a (or its estimate, sy) starts approaching and 

exceeding 1.5. Recommendations on its use to a compute an estimate of the 

EPC term are summarized in Section 6. 



5.7 (1-a) 100% l.!CL ofthe Mean of a Lognormal Population Based Upon 

the Chebyshev Theorem (Using the MVUE of Mean and its Standard 

Error) 

The program ProUCL uses equation (23) on the MVUEs of lognormal 

mean and sd to compute a UCL (denoted by (1 -a) 100 % Chebyshev (MVUE) 

) of the population mean of a lognormal population. In general, if J.l 1 is an 

unknown mean, tl', is an estimate, and cf(~l'\) is an estimate of the standard error 

of~\, then the following equation, 

UCL = ji', +((1/a:) -1)112 cf'(~f\) (26) 

s.. 
~ 

will give a (1-a) 100% UCL for ~ 1 , which should tend to be conservative, but 

this is not assured. For example, for a lognormally distributed data set, a 95% 

(with a =0.05) Chebyshev (MVUE) UCL of the mean can be obtained using the 

following equation, 

(27) 

where, ~~and a"'(~f\) are given by equatio 

for lognormally distributed data sets, the pro L, uses equation (26) 

to compute a (1-a) 100% Chebyshev (MVUE) UCL of mean. It should be 

noted that for lognormally distributed data sets, some recommendations to 

compute a 95% UCL of population mean are summarized in Table Al of the 

Recommendations and Summary Section 6.0. 

A-19 



(1-a.) 100% UCL of the Mean Using the Jackknife and, Bootstrap 

Procedures 

Bootstrap and jackknife procedures as discussed by Efron (1981, 1982) 

are nonparametric statistical techniques which can be used to reduce the bias 

of point estimates and construct approximate confidence intervals for 

parameters, such as the population mean. These two procedures require no 

assumptions regarding the statistical distribution (e.g., nonnal or lognormal) 

for the underlying population, and can be applied to a variety of situations no 

matter how complicated. 

Let x1, x2, ••• , x,. be a random sample of size n from a population with an 

unknown parameter, e (e.g .• 8= J.lJ) ' and let e be an estimate of e, which is a 

function of all n observations. For example, the parameter, 6, could be the 

population mean, and a reasonable choice for the estimate, a, might be the 

sample mean,x. Another choice for r, is the MVUE of a mean of a lognormal 

population, especially when dealing with lognormal data ~ets. 

5.8 (1-a.) 100% UCL:oftlie:·Mean Based Upon the Jackknife Procedure 

In the jackknife approach, n estimates of6 are computed by deleting one 

observation at a time (Dudewicz and Misra (1988)). Specifically, for each 

index, i, denote by ffw the estimate of6 (computed similarly as 6') when the 

ith observation is omitted from the original sample of size n, and let the 

arithmetic mean of these estimates be given by 

1 n 

d;;: -.E ~i)" 
n ;~r 

(28) 
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A quantity known as the ith "pseudo-value" is defined by 

J. = n d - (n - I)tl 
r (I)" 

(29) 

The jackknife estimator ofe is given by 

(30) 

If the original estimate ff is biased, then under certain conditions, part of the 

bias is removed by the jackknife procedure, and an estimate of the standard 

error of the jackknife estimate, J(ff'), is given by 

(31) 

Next, consider the t-type statistic given by 

(32) 

The t-type statistic given by (32) has an approximate Student's t distribution 

with n-1 degrees of freedom, which can be used to derive the following 

approximate (1-cx)JOO% UCL for 8, 

UCL = ~d) + t a,n + 1 dJfd)" (33) 

If the sample size, n, is large, then the upper a t-quantile in equation (33) can 

be replaced with the corresponding upper ath standard normal quantile, za.. 

Observe, also, that when ff' is the sample mean,x, then the jackknife estimate 
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is also the sample mean, J(X) =x, and the estimate of the standard error given 

by equation (31) simplifies to s)n 112
, and the UCL in equation (33) reduces to 

the familiar t- statistic based UCL given by equation (14). The program 

ProUCL uses the jackknife estimate as the sample mean leading to J(X)=x, 

which in tum translates equation (33) to the UCL given by equation (14). 

5.9 (1-a) 100% UCL of the Mean Based Upon Standard Bootstrap 

Procedure 

In the bootstrap procedure, repeated samples of size n are drawn with 

replacement from a given set of observations. The process is repeated a large 

number of times (e.g., 2000), and each time an estimate, e'j, of6 is computed. 

The estimates thus obtained are used to compute an estimate of the standard 

error of 6'. A description of the bootstrap method, illustrated by application 

to the population mean, IJ.1, and the sample mean, X', is given as follows: 

·Step 1. 

Step 2. 

Let (x;1, X;2, ... , x;,J represent the ith sample of size n with 

replacement from the original data set (x1, x2, ... , x,). Then 

compute the sample mean and denote it by x-i. 

Perform Step 1 independently N times (e.g., 1000-2000), each 

time calculating a new estimate. Denote those estimates by 

x1,x2, .... ,x,. The bootstrap estimate of the population mean is the 

arithmetic mean, xB, of the N estimates xi:i= 1,2, ... ,N. The 

bootstrap estimate of the standard error of the estimate, x, is given 

by, 
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d "' B (34) 

If some parameter, e (say, a population median), other than the mean is 

of concern, with an associated estimate (e.g., the sample median), then the 

same steps described above could be applied with the parameter and its 

estimate used in place of fl 1 and x. Specifically, the estimate, ff'i, would be 

computed, instead of X;, for each of theN bootstrap samples. The general 

bootstrap estimate, denoted by eB, is the arithmetic mean of theN estimates. 

The difference, 6 B - 0, provides an estimate of the bias of the estimate, ff', and 

the bootstrap estimate of the standard error of Ef is 

l N ( -~ -L ~-8B/· 
N-l ;~r 

(35) 

The (1-cx)JOO% standard bootstrap UCL for 6 is given by 

(36) 

The program ProUCL computes the standard bootstrap UCL by using the 

population AM and sample AM, respectively given by tJ.1 andx-. It is observed 

that the VCL obtained using the standard bootstrap procedure is quite similar 

to the UCL obtained using the Student's t-statistic as given by equation (14), 

and, as such, does not adequately adjust for skewness. 
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5.10 (l-ex) 100% UCL of the Mean Based Upon Bootstrap t Procedure 

Another variation of the bootstrap method, called the "bootstrap t" by 

Efron (1982), is a nonparametric procedure which uses the bootstrap 

methodology to estimate quantiles of the pivotal quantity t- statistic given by 

equation (13). Rather than using the quantiles of Student's t-statistic, Hall 

(1988) proposed to compute estimates ofthe quantiles of statistic given by 

equation ( 13) directly from the data. 

Specifically, in Steps 1 and 2 described above, if i is the sample mean 

computed from the original data, and xi and si;, i are the sample mean and 

sample standard deviation computed from the ith resampling of the original 

data, the N quantities t; =(.,fn)(ji -i)fsx,J are computed and sorted, yielding 

ordered quantities t(l) s t<2) s ··· s t(N)· The estimate of the lower a.th quantile 

of the pivotal quantity in equation (13) is tu.B = t(uN)· For example, ifN = 1000 

bootstrap samples are generated, then the 50th ordered value, trso;, would be the 

bootstrap estimate of the lower O.OSth quantile of the pivotal quantity in 

equation (13). Then a (1-a) 100% UCL of population mean based upon the 

bootstrap-t procedure is given by 

(37) 

The program, ProUCL, computes the Bootstrap-t UCL based upon the 

quantiles obtained using the sample mean, i. It is observed that the UCL based 
-

upon the bootstrap-t procedure is more conservative than the other UCLs 

obtained using the Student's t, modified t, adjusted CLT, and the standard 

bootstrap procedures. This is specially true for skewed data sets. This 
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procedure seems to adjust for skewness. However, this procedure was not 

included in the Monte Carlo simulation study conducted by Singh, Singh, 

Engelhardt, and Nocerino (2000). This procedure needs further investigation 

to study the coverage probabilities provided by the UCL based upon the 

bootstrap-t method. 

Note: For lognormally distributed data sets, one may want to use the jackknife 

and the standard bootstrap methods on theMVUE of the population mean, ~1 , 

given by equation (9). However, these procedures are not included in the 

program, ProUCL. 

6.0 Recommendations and Summary 

This section describes the summary and recommendations on the 

computation of a 95% UCL of the unknown population arithmetic mean, t-L1, 

of a contaminant data distribution. These recommendations are based upon the 

findings of Singh, Singh, and Engelhardt (1997, 1999), and Singh et al. ( 

2000). Recommendations have been summarized for: 1) normally distributed 

data 'sets, 2) lognonnally distributed data sets, and 3) data sets which are 

neither normal nor lognormal (non-parametric data). 
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6.1 Recommendations to Compute a 95o/o UCL of the Population Mean, 

~I 

6.1.1 Normally Distributed Data sets 

• For normally distributed data sets, a UCL based upon the Student's t­

statistic as given by equation (14) provides the optimal UCL of the 

population mean. Therefore, for normally distributed data sets, one 

should use a 95% UCL based upon Student's t-statistic. 

• The 95% UCL of mean given by equation (14) based upon Student's t 

can also be used when the sd of the log-transformed data is less than 

0.5, or when the data set approximately follows a normal distribution. -
6.1.2 Lognormally Distributed Data sets 

For skewed data sets, there is no simple solution to compute a UCL of 

the population mean, ~ 1 • Singh et al. (2000) noted that the UCLs based upon 

the skewness adjusted methods, such as the Johnson's modified- t and Chen's 

adjusted CLT, do not provide the specified coverage (e.g., 95%) to the 

population mean even for mildly to moderately skewed (e.g., a in (0.5, 1.0)) 

data sets for samples as large as 100. The coverage of the population mean 

by these UCLs gets poorer (much smaller than the specified coverage) for 

highly skewed data sets as defined in Section 4.2. 

For lognormally distributed data sets with a standard deviation (sd), o, 

exceeding 1.0 (for moderately to highly skewed data), the use of Land's H-
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statistic results in unacceptably large UCL values (H-UCL), especially for 

samples of small sizes (e.g., smaller than 20-25). Note that even a small 

increase in the sd, a, increases skewness considerably (equations (6) and (7)). 

For example, for a lognormal distribution, when o = 2.5, skewness -

11825.1; and when a =3, skewness- 729555. In practice, the occurrence of 

such highly skewed data sets (e.g., o ~3) is not very common. Nevertheless, 

these highly skewed data sets can arise occasionally and, therefore, require 

separate attention. Singh et al. (2000) observed that when the sd, a, starts 

approaching 2.5 (that is, for lognormal data, when CV> 22.74 and skewness 

> 11825.1 ), even a 99% Chebyshev (MVUE) UCL fails to provide the desired 

95% coverage for the population mean, iJ-1• This is especially true when the 

sample size is small (<20-25). For such extremely skewed data sets, the 

larger of the two UCLs: the 99% Chebyshev (MVUE) UCL and the non­

parametric 99% Chebyshev (Mean, Std) UCL, may be used as an estimate of 

the EPC term. Another candidate to use as an estimate of the EPC term is the 

UCL based upon Bootstrap-t procedure. These issues need further 

investigation. It is also desirable to study other distributions such as a Gamma 

distribution to model the highly skewed environmental data sets. 

It is also noted that, as the sample size increases, the H-UCL starts 

behaving in a stable manner. Therefore, depending upon the sd, a (actually its 

MLE o), for lognormally distributed data sets, one can always use the H­

UCL for samples of larger sizes (e.g., 50-70 or larger). This large sample size 

requirement increases as the sd, 0, increases, as can be seen in Table AI. The 

program, ProUCL, can compute an H-UCL for samples of sizes up to 1000. 

For lognonnally distributed data sets of smaller sizes, some alternative 

procedures to compute a 95% UCL of the population mean are summarized 
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in the following Table t\1. 

For lognormal distributions~ since skewness (as defined in Section 4.2) 

is a function of a, recommendations for the computation of the UCL of the 

population mean are summarized in Table AI for various values of the MLE a 
of o and the sample size, n. Here a is ML estimate of o, and is given by the 

sd of log-transformed data. Note that the following table is applicable to the 

computation of a 95% UCL of the population AM based upon lognormally 

distributed data sets. 
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Table Al. Summary Table for the Computation of a 

95% UCL of the Unknown Mean, J.l 1 of a Lognormal Population 

0 Sample Size, n Recommendation 

a < 0.5 For all n (~5) Student's tor H-UCL 

0.5 s; 0 < For all n H-UCL 

1.0 

1.0 s; 0 < 1.5 n < 25 95% Chebyshev (MVUE) UCL 

n ~ 25 H-UCL 

n<20 99% Chebyshev (MVUE) UCL 

1.5 s: a <2.o 20::; n<50 95% Chebyshev (MVUE) UCL 

n;;::50 H-UCL 

n<25 99% Chebyshev (MVUE) UCL 

2.0 s; 0 <2.5 25 s; n < 70 95% Chebyshev (MVUE) UCL 

n ~ 70 H-UCL 

n < 30 Larger of (99% Chebyshev (MVUE) UCL, 

99% Chebyshev(Mean, Std)) 

2.5 s; 0 < 3.0 30 :::; n <70 Larger of (95% Chebyshev (MVUE) UCL, 

95% Chebyshev(Mean, Std)) 

n ;;::70 H-UCL 

n small Needs further investigation 

3.0 $ 0 n>lOO H-UCL 
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6.1.3 Data sets Without a Discernable (non-parametric) Distribution 

• For non-parametric mildly to moderately skewed data sets (e.g., o or its 

estimate,O in the interval (0.5, 1)), one may use a 95% Chebyshev 

(Mean, Std) UCL for the population mean, 1-11• 

• For populations which are neither nonnal nor lognormal, for 

moderately to highly skewed data sets (e.g., o in the interval (1.0, 

2.0)), one may use ·a 97.5% Chebyshev (Mean, Std) UCL of the 

population mean, }.L1 , to obtain an estimate of the EPC term. 

• For highly skewed to extremely highly skewed data sets with o in the 

interval (2.0, 3.0), one may use a 99% Chebyshev (Mean, Std) to 

compute a 95% UCL of the population mean, }.L1• 

• Extremely skewed data sets with o exceeding 3.0, are badly behaved 

and need further investigation. It should be noted that for an extremely 

skewed data set, even a Chebyshev inequality based 99% UCL of the 

mean fails to provide the desired coverage (e.g., 0.95) of the population 

mean. Thus, a Chebyshev inequality based UCL may not be used to 

estimate the EPC term for data sets which are extremely highly skewed 

with o approaching and exceeding 3.0. 

• It is observed that the UCL based upon the non-parametric bootstrap-t 

procedure is more conservative (larger) than the other UCLs obtained 

using the Student's t, modified t, adjusted CLT, and standard bootstrap 

procedures. This is specially true for skewed data sets. The non-
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parametric bootstrap-t procedure was not included in the Monte Carlo 

simulation study conducted by Singh et al. (2000). It is likely that the 

UCL based upon the bootstrap-t procedure may provide better coverage 

to the population mean. This procedure needs further investigation. 

• It is also desirable to study other distributions, such as a Gamma 

distribution, to model the highly skewed environmental data sets. 

6.2 Summary of the Procedure to Compute a 95%, UCL of Population 

Mean 

• The first step in computing a UCL of a population arithmetic mean is 

to test for the data distribution, such as normality or lognormality of the 

data set. ProUCL has three procedures to test for normality: the 

graphical test based upon a Q-Q plot, the Lilliefors test, and the 

Shapiro-Wilk W test. 

• ProUCL generates a quantile-quantile (Q-Q) plot to graphically test the 

normality or lognormality of the data. On this graph, a linear pattern 

displayed by data suggests approximate normality or lognonnality. On 

this graph, points well-separated from the majority of data are potential 

outliers. 

• After performing the normality test, Pro UCL informs the user about the 

data distribution (normal or lognormal). 
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• For a normally distributed ( orapproximatelynonnally distributed) data 

set, the user is advised to use Student's-t distribution based UCL ofthe 

• 

mean. 

For lognormal data sets, the program, ProUCL, recommends (as 

summarized in Table A 1, Section 6.1) a procedure to obtain a 95% UCL 

based upon the sample size and standard deviation of the log­

transformed data, fJ. Pro UCL can compute a H-UCL for samples of size 

up to 1000. 

• Non-parametric UCL computation methods such as the modified-t, CLT 

method, adjusted CLT method, bootstrap and jackknife procedures are 

also included in the program, ProUCL. However, it is noted that non­

parametric UCLs based upon these procedures do not provide adequate 

coverage to the population mean for moderately skewed to highly 

skewed data sets (Singh et al., 2000). 

• 

• 

For data sets which are neither normal nor lognormal, a non-parametric 

UCL of the mean based upon the Chebyshev theorem is preferred. The 

Chebyshev (Mean, Std) UCL does not depend upon distributional 

assumptions and can be used for moderately to highly skewed data sets 

which are neither normal nor lognormal. 

It should be noted that for extremely skewed data sets (e.g., with o 

exceeding 3.0), even a Chebyshev inequality based 99% UCL of the 

mean fails to provide the desired coverage (e.g., 0.95) of the population 

mean. A procedure to compute the EPC term based upon the Chebyshev 

A-32 



(Mean, Std) UCL is described in the recommendation Section 6.1. 

It should be pointed out that depending upon his or her application, the user 

may decide to use (or not use) any of the 10 available procedures incorporated 

in the program, ProUCL. 
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